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Introduction

What Is the Card Editor?

The Card Editor is the program which is used to create the card deck files for Onyx, the game of sexual 
exploration. Onyx keeps all of its actions stored in five external card deck files: an Action deck, a Fate deck, a 
Center Stage deck, a Torture Chamber deck, and a Get Naked deck. These cards are drawn during play, and 
describe actions the players will perform, as well as other things which will influence game play.

Note that card decks that you create with this version of the Card Editor can only be used with registered copies of 
Onyx!

System Requirements

Macintosh:
Onyx requires an Intel-based Macintosh running Mac OS X 10.6 or later. PowerPC Macs are not supported with 
Onyx 3.6; the last version that will run on a PowerPC Mac is Onyx 3.1.2.

Windows:
Onyx requires Windows XP SP2 or later. 

Linux:
Onyx requires an x86 Linux machine (PowerPC, Sparc, Alpha, and other platforms are not supported), with GTK 
2.8+, glibc-2.4, and libstdc++.so.6. On 64-bit Linux installations, the ia32-libs 32-bit compatibility package must 
be installed as well.

Macintosh:
The Card Editor for Mac OS X is a .dmg file. Double-click on the .dmg file to mount it, then drag the folder to 
your Applications folder on your hard drive.

To uninstall the Card Editor, just drag the Card Editor folder to the Trash.

Windows:
To install the Card Editor, double-click the installer file and follow the on-screen instructions. The installer will 
create a program group for the Card Editor and set up the application’s icons. It will also install an uninstaller 
program.

To uninstall the Card Editor, run the uninstaller.

Linux:
Uncompress the .tgz file. This will create a folder with all the necessary files. You can run the Card Editor directly 
from this folder.

Installing the Card Editor



To start the program, double-click on the Card Editor icon, or (Windows) select it from the Start menu. If this 
is the first time you’ve run the Card Editor, you will be asked to register the program by entering your name and 
serial number. The serial number for the Card Editor is the same as the serial number for your registered copy of 
Onyx.

Each “card” you create or edit with the Card Editor contains a single action the players will perform. There are 
five different kinds of “cards” you can edit with the Card Editor; these different types of cards are used at different 
points in the game.

Action cards are the kind of card you see in Onyx when one person must work off the debt to another person. The 
Action cards describe fun “actions” done for the benefit of the person who is owed the debt.

Fate cards are drawn whenever a player lands on the Fate square. These cards can describe a player gaining or 
losing money, or moving to a different square, or gaining or losing Opt Outs. Many Fate cards also describe a fun, 
sexy action in which the players are thrown together by the hand of Fate. Think of the Fate square as a “pot luck” 
square; role-playing actions are appropriate here.

Center Stage cards are drawn whenever a player lands on the Center Stage square. A player on Center Stage is on 
display, and must do something for the amusement or entertainment of the other players, or allow the other players 
to do something to him or her.

Torture Chamber cards are drawn when someone lands on the Torture Chamber square, and describe an action 
that will be done to tease, frustrate, or torture the hapless player.

Get Naked cards are played when the first player gets completely undressed. They describe how all the other 
players will get naked.

One card deck file can only contain one kind of card. For example, if you create an Action deck, you can only put 
Action cards in that deck. You cannot change an Action deck into, for example, a Torture deck; the type of deck is 
set when the deck is created.

When you start the Card Editor, you can create a new card deck, or you can open an existing card deck. To create a 
card deck, choose “New” from the “File” menu. To open an existing deck, choose “Open” from the “File” menu.

If you edit an existing deck, the Card Editor will load the card deck and the Edit, List, and Card Preview windows 
appear. At this point, you can edit a card, add a new card, change the deck information, or append another card 
deck.

If you create a new card deck, you will be asked what kind of deck you are creating. Select the type of deck from 
the pop-up menu. At this point, the Card Editor will automatically begin adding a new card.

Card files are located in the same folder as Onyx (on Mac OS or Linux), or in the application support folder 
(on Windows). The application support folder is hidden by default on Windows, but using File -> Open in the 
Card Editor will navigate you to the right place anyway.

Using the Card Editor



Once you have loaded a card deck or created a new one, it’s time to start writing cards!

When you are writing cards, you'll work in three windows: the main Edit window, where you can describe the card 
and enter its text; the Preview window, which will show you what the card will look like when the card is played 
during a game; and the List window, which shows a list of all the cards in the deck.

Adding and Editing Cards

Main Window

Card List Window

Preview



The Preview Window shows you a preview of how your card will 
look when it is displayed in Onyx, so you can check to make sure 
everything is displaying the way you intend it to.

It also displays a series of icons below the text; these icons will light 
up to tell you if this card causes a player to remove clothing, reach 
orgasm, gain or lose money, change position on the board, or gain or 
lose an Opt Out token.

The Preview window changes automatically as you type your text in 
the Main Window.  Tokens are filled in automatically, using a list of 
generic player names in the Card Editor. The Preview window will 
pay attention to the target sex you specify in the Main Window and 
fill in the players’ information accordingly.

You can close or open the Card List window and the Preview 
window by using the menu commands under the View menu. By 
default, both windows are displayed when you run the Card Editor.

The Card List Window shows you a list of all the cards in the file. 
You can go to a particular card by double-clicking on its title. You 
can delete a card by hilighting its title and clicking the “Delete” 
button. You can begin entering a new card by clicking on the 
“New...” button. You can also bring up the Find dialog by clicking 
on the “Find...” button.

Note: You cannot delete a card if it is the only card in the deck. 

CAUTION: You will not get a confirmation dialog. The card you’re 
working on will be deleted immediately. There is no Undo. Be careful 
when you’re deleting cards!

The “L” column in the List Window displays the card’s spice level. 
A “+” in the “O” column indicates a card that causes orgasm. A “-” 
in the “D” (“dress”) column indicates a card that involves removing 
clothing.



The Main Window is where you will enter all the information about the particular card you’re writing. Here’s what 
the various controls and buttons do.

NAVIGATION

You move around in the deck by using the Card List window. Double-clicking on a card’s title in the Card List 
window will take you to that card, and you can begin editing it. The information for that card will be placed in 
the Main Window, and the card’s text will appear in the Preview Window. You can also step backward and forward 
through the deck by using the small arrows in the Main Window or the Preview Window.

Card Title: Enter the title of the card here. The title will appear on the top of the card when this card is drawn. 
You should try to make all your cards’ titles unique. A title is limited to 32 characters in length.

Help Button: Click the HELP button to bring up the online help.

Target Sex: Use this control to tell Onyx what sex the target of this card should be. Important: This control only 
tells Onyx what sex the target of your card should be. It does not tell Onyx what sex the other players should be. 
The “target” of the card is not necessarily the current player; the target is the player upon whom the card will be 
played. The “target” of an Action card is the person who owns the property, not the person who is working off the 
debt! The target of a Get Naked card is the first person who reaches Dress Level 5. The target of all other cards is 
the person who lands on the square for that card (the person who lands on a Torture square, for example).

Spice Level Buttons and Indicator: This is where you specify what spice level this card is. As you move the slider, 
you will see a brief description of what that spice level means.

You can navigate through the cards by pressing the up and down arrows next to the card number in the corner of 
the window.

BASIC CARD INFORMATION



This is where you describe when Onyx should draw the card, and how to handle the card being played.

Can Opt Out checkbox: Determines if 
a player can Opt Out of this card. Action 
cards always have this checked; Get Naked 
cards never have this checked. Check it 
for other cards (such as Fate cards) only if 
it’s appropriate. For example, a Fate card 
which causes the player to lose $100 should 
not have the Opt Out checked; a Fate card 
which tells the player to wear a blindfold 
for the next 5 turns should.

Lose Clothing checkbox: Put a check in 
this box if the action describes a way for the 
target to lose some item of clothing. Make 
sure that the action you describe goes with 
the Dress Level for this card! For example, 
if your card says “Player 1 is to remove the 
Target’s shoes and socks,” the Dress Level 

should be 1 (you don’t want Onyx to draw this card if the target has already lost his or her shoes and socks). If the 
players do not Opt Out of this card, Onyx will reduce the Target’s Dress Level by one when the card is played. 
When the Lose Clothing checkbox is checked, the Lose Clothing token lights up in the Card Preview window.

Causes Orgasm check box: If this card describes an action which will bring one or more players to orgasm, put a 
check in this box. Onyx will draw these cards infrequently, and never before the players have lost all their clothing; 
these cards should make up a small percentage of the deck. When the Causes Orgasm checkbox is checked, the 
Causes Orgasm token lights up in the Card Preview window. 

Participants: Here you tell Onyx how many players will be involved in this action. For an Action card, this is 
always 2 (the property owner, or target, and the person who is working off the debt); for other cards, such as 
Center Stage cards, this number can change. If you put a zero in this field, that means every player who is sexually 
compatible with the target should be involved. 

Dress: This is where you tell Onyx what level of dress the target should be at. If you specify 3, for example, Onyx 
will draw this card only if the target has lost his or her shoes, socks, and shirt. Again, this specifies only the dress 
level of the target, not the other players involved. If you specify Dress Level 5, you can assume that everybody is 
naked. 

If you choose, you can put a range of dress levels in here. Let's say you have a card that should be drawn if a 
player is topless or if a player has lost his or her pants, but should not be drawn if a player is completely dressed or 
completely naked. You can specify "Dress Level from 3 to 4" and Onyx will draw the card if the target is topless or 
is pantsless.

Delta Position: A card can move a player’s token on the board. If you want this card to move a player’s token, put 
a number here. When this card is drawn, that player will move the number of squares you put here. (If you specify 
4, for example, the target will move 4 squares from his or her current square.) If you want to move the player to 
a certain square—for example, to the Center Stage square—put the number of the square you want the target to 

CARD PROPERTIES TAB



move to, preceded by a “-” sign. The square numbers start at 1 for the Start square and are numbered clockwise 
around the board. Prison is square 21. So, for example, if you want to move the target to the Start square, put -1 
in this field.

This is not usually appropriate for Action cards. It will move the target; since the target for an Action card is the 
owner of the property, it will move the property owner, not the current player! It also is not appropriate for Get 
Naked cards. In general, you should use this field for Fate cards.

Delta Money: If you put a number in this field, the target will gain that much money (if the number is positive) 
or lose that much money (if the number is negative). Usually appropriate only for Fate cards.

Delta Opt Out: If you put a number in this field, the target will gain that many Opt Outs (if the number is 
positive) or lose that many Opt Outs (if the number is negative). Usually appropriate only for Fate cards. Do 
not put more than 1 or -1 in this field. If the target already has 3 Opt Outs, Onyx will not draw any cards that 
increase Opt Outs (since you can’t have more than 3). If the target doesn’t have any Opt Outs, Onyx will not draw 
any cards that cause the target to lose Opt Outs.

Bicurious Players: At the bottom of the window is a checkbox labelled “This card is appropriate for bicurious 
players.” Onyx 3 allows a player to set his or her sexual orientation as “Bicurious.” Bicurious is not the same as 
bisexual; Onyx 3 treats a bicurious player as “mostly straight.” Players who choose the bicurious sexual orientation 
may be involved in mild actions with players of the same sex, but won’t be involved in overtly sexual actions such 
as sexual contact below the waist.

When should you consider a card to be acceptable for bicurious players?

That’s a matter of judgment, and no doubt people will have slightly different ideas about what kinds of actions 
qualify as “not overtly sexual.” Generally, cards where two players make out, which may includes things like kissing 
or fondling above the waist, are within what Onyx considers to be “bisexual,” and cards involving actions such as 
massaging, spanking, and the like are okay as well. Cards involving contact with genitals or other more explicitly 
sexual activities generally should not be marked as acceptable for bicurious players.

During a game, if two people of the same sex are involved in an action, and they have both chosen “bicurious” as 
their sexual orientation or one has chosen “bicurious” and one has chosen “bisexual” or “gay,” Onyx will only draw 
cards that are marked as being appropriate for bicurious players.



Entering Card Text

To see and edit the text of a card, click on 
the Card Text tab in the main edit window. 
This is where you type the actual action of 
the card.

When you enter the card text, you can 
include “tokens” in the text. The tokens 
are processed by Onyx when the card is 
drawn, and will be replaced by different 
things, such as the names of the players or 
the proper sex pronouns for the players. You 
can also enter tokens which will cause Onyx 
to display a countdown timer when the card 
is drawn, if the players don’t Opt Out. As 
you enter text, the Preview window will “fill 
in” the tokens as you type them, so you can 
make sure you’re using the right tokens.

The simplest token is a code for the name of a player. For example, if you type %target% into an Action card, 
then Onyx will fill in the name of the person who owns the property. So a line reading “%target%, please lie on 
your back” might be displayed during a game as “Kelly, please lie on your back” if the property owner is named 
Kelly.

Tokens can also cause events to occur during a game. For example, if your card contains the token %m#%, where 
# is a number, then when the players click the “Do It!” button during a game, a timer will run for that number of 
minutes. The token %m1% will be displayed as 1, and will cause a timer to run for one minute.

Tokens must be typed exactly! %target% and %Target% are not the same. Using the token %Target% will not 
work.

You can get a complete list of the tokens you can use by clicking the Help button while you’re working on a card. 
This will show you all the tokens supported by this version of the Card Editor and Onyx. Tokens are always begin 
and end with “%”. Some special notes about some of the tokens:

%target%: The name of the target—the owner of a property for an Action card, the first person undressed for a 
Get Naked card, or the current player for any other card.

Understanding and Using Tokens



%player1%: This will be replaced by the name of the first player involved in an action. In the case of an Action 
card, %player1% is the player who is working off the debt.

%player2% %player3% %player4% %player5%: These tokens will fill in the name of the second, third, fourth, 
and fifth players involved in an action with the target. They are never used for Action cards, since Action cards 
only allow 2 players. Do not use these tokens if your card does not call for that many players, or the results will be 
unpredictable! 

%mX% and %dX%: Use these tokens to tell Onyx to start a timer if the players choose not to Opt Out of this 
card. X is replaced by a number; do not put a space between the %d or the %m and the number. Example: %m3% 
runs a timer for 3 minutes; %d30% runs a timer for 30 seconds.

Entering Card Props

To see and edit the props that a card uses, 
click on the Props tab in the main edit 
window. 

Props are items that the players need to 
have in order to play the card. For example, 
if a card says to blindfold another player, 
then the blindfold is a prop. If a card 
instructs one player to use a vibrator on 
another player, then the vibrator is a prop.

Onyx keeps track of the props that the 
players have on hand. When a game starts, 
Onyx displays a list of all the props a deck 
of cards will use, and the players can check 
off which props they have. Onyx will never 
draw a card that requires a prop the players 
don’t have. The “Props” tab will change to 
“•Props” if the card you’re working on uses 
any props.
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deck. When you make a deck of cards, you MUST make sure that 
every deck uses the same list of props that is in the Action deck!

In the Props tab, you will see a button labelled “Load prop list from 
another deck.” When you work on a deck of cards that is not an 
Action deck, use this button to load the list of props from the Action 
deck. If you add a prop to the list of props, make sure that you load 
the list of props into the Action deck. The prop list in all card decks 
must be the same!



When you first create a brand-new card deck, the Card Editor will fill in a list of default props to use as a starting 
point. You do not need to use these props if you don’t want to. You can delete them and create your own; just 
make sure that all the cards files in one set are using the same list of props.

To delete a prop, hilight it in the list and hit the - button. To add a new prop, hit the + button. There is a limit of 
32 props in any one deck. If you have 32 props, you won’t be able to add any more.

One card can use more than one prop.

Entering Card Roles

To see and edit the roles that a card calls 
for, click on the Roles tab in the main edit 
window. 

Roles are general descriptions of the 
activities people are willing to engage in. 
Because different people have different 
tastes and limits, Roles allow a player to 
determine the kinds of activities he or 
she will and will not do. Onyx allows the 
players to choose the Roles they are willing 
to participate in.

Roles are very general, and don’t describe 
specific acts. For example, some people 
don’t ever want to play a submissive role 
in their sexual activities. These people 
can uncheck the “Submissive” role, and 
Onyx will not draw cards assigning actions 
which would cause those players to act in a 
submissive manner.

When you create cards, think about the roles that the participants in the activities you’re describing will play. 
If they match any of the roles in the list, be sure to check the appropriate checkboxes to let Onyx know what 
roles your card calls for. (Many cards will not call for any specific roles; most cards probably won’t have any roles 
selected.)

You can set roles both for the Target of a card (the owner of a property in the case of Action cards; the player who 
has landed on a square for Center Stage, Torture, and Fate cards) and assign different roles for the other players 
involved. So, for example, if you have a card in which the target is tied down and blindfolded by the other player, 
you would choose “Restrained” and “Blindfolded” for the Target, but nothing for the other player. If you have a 
card where the target is spanked by another player, you would choose “Pain-Receiving” for the target, and “Pain-
Giving” for the other player.



In most cases, the cards you write will involve only two players: the owner of a property, and the person working 
off a debt. In some cases, for example in Center Stage or Torture cards, the cards you write may involve more than 
two players.

When you create a card that calls for more than two players (for example, if you create a Center Stage card that 
calls for three players), Onyx will check to see if the target has that number of sexually compatible partners. If 
not, Onyx won’t draw the card. If so, Onyx will make a list of all the players who are sexually compatible with the 
target, then put that list in a random order, and then finally hand the list to the card. So, when you write cards 
that call for many players, you don’t know in advance who will be assigned to the target.

For example, let’s consider a game with three straight men (Albert, Bob, and Cory) and three straight women 
(Denise, Ellen, and Francine). Ellen has just landed on Center Stage, and Onyx has drawn a card that calls for 3 
players.
In this case, Ellen is the Target. Onyx will check to see if there are two partners who are sexually compatible with 
Ellen. There are; Ellen has 3 partners (Albert, Bob, and Cory). So Onyx first builds a list of Ellen’s partners, then 
puts the list in random order. The list now reads Bob, Cory, Albert. The card calls for a total of 3 players, and 
Ellen counts as one of those players, so Ellen’s partners are Bob and Cory. Onyx will now go through the card, 
replace %target% with “Ellen,” replace %player1% with “Bob,” and replace “%player2” with “Cory.”

As you can tell, the other players involved in an action will always be compatible with the target, but they may not 
be compatible with each other. You can specify the sex of the target, but that doesn’t necessarily mean you know 
what sex the other players are! In the example above, suppose Ellen were bisexual, and Denise were bisexual as well. 
Now Ellen has 4 potential players: Albert, Bob, Cory, and Denise. Onyx will shuffle the list of names (Denise, 
Albert, Cory, Bob) and then pass the proper number of players to the card. Now %target% is Ellen, %player1% is 
Denise, and %player2% is Albert. Don’t make any assumptions about what sex anyone except the target is!

In most cases, the cards you write will involve only two players: the owner of a property, and the person working 
off a debt. In some cases, for example in Center Stage or Torture cards, the cards you write may involve more than 
two players.

When you create a card that calls for more than two players (for example, if you create a Center Stage card that 
calls for three players), Onyx will check to see if the target has that number of sexually compatible partners. If 
not, Onyx won’t draw the card. If so, Onyx will make a list of all the players who are sexually compatible with the 
target, then put that list in a random order, and then finally hand the list to the card. So, when you write cards 
that call for many players, you don’t know in advance who will be assigned to the target.

For example, let’s consider a game with three straight men (Albert, Bob, and Cory) and three straight women 
(Denise, Ellen, and Francine). Ellen has just landed on Center Stage, and Onyx has drawn a card that calls for 3 
players.
In this case, Ellen is the Target. Onyx will check to see if there are two partners who are sexually compatible with 
Ellen. There are; Ellen has 3 partners (Albert, Bob, and Cory). So Onyx first builds a list of Ellen’s partners, then 
puts the list in random order. The list now reads Bob, Cory, Albert. The card calls for a total of 3 players, and 
Ellen counts as one of those players, so Ellen’s partners are Bob and Cory. Onyx will now go through the card, 
replace %target% with “Ellen,” replace %player1% with “Bob,” and replace “%player2” with “Cory.”

As you can tell, the other players involved in an action will always be compatible with the target, but they may not 

Multiple Players for One Card



be compatible with each other. You can specify the sex of the target, but that doesn’t necessarily mean you know 
what sex the other players are! In the example above, suppose Ellen were bisexual, and Denise were bisexual as well. 
Now Ellen has 4 potential players: Albert, Bob, Cory, and Denise. Onyx will shuffle the list of names (Denise, 
Albert, Cory, Bob) and then pass the proper number of players to the card. Now %target% is Ellen, %player1% is 
Denise, and %player2% is Albert. Don’t make any assumptions about what sex anyone except the target is!
If you specify “0” in the number of players, Onyx will interpret that to mean “everyone who is compatible with 
the target.”  You do not necessarily have any way of knowing how many players this will be. In a game with only 
2 players, there will be only two people involved; in a game with 6 players, it’s possible that all 6 will be involved! 
In the first example above, if Ellen draws a card which calls for 0 players, there will be 4 people involved: Ellen, 
Albert, Bob, and Cory. In the second example, there will be 5 participants: Ellen, Albert, Bob, Cory, and Denise. 
Don’t make any assumptions about the number of players involved if you specify 0 participants, and don’t use 
tokens like %player2%, %player3%, etc. Instead, use phrases like “all the other appropriate players.”

How Onyx Draws Cards

Many programs that use a “card deck” metaphor choose a random number between one and the number of cards 
in the deck and display that card. This is not the best way to draw cards; by using this system, it’s possible that 
some cards will be drawn twice in a row, and if the random number generator being used isn’t very good then 
some cards will get drawn more often than others. Onyx uses a more realistic system. All the cards in the deck are 
“shuffled” to put them in a random order; then Onyx draws a card off the top of the deck, plays it if it can be used 
in the current situation, then discards it. When no more cards are left in the deck, Onyx reshuffles all the discarded 
cards and starts again.

Finding and Editing Cards

If you want to edit a card you’ve already written, choose “Find Card...” from the Deck menu, or click the “Find...” 
button in the Card List window. The Card Editor will show you the Find dialog. You can go straight to a particular 

card number this way. Or, you can search for 
a particular piece of text in the card’s title or 
body.

By default, a search is not case sensitive—
that is, if you search for the phrase “MORE 
FUN,” the card editor will find a card 
containing “More Fun.” 

After you have used “Find” to search for a 
card, you can use “Find Again” to locate the 
next card in the deck that matches the search 
criteria. 

You may also quickly search for text within a 
card’s body by typing the search term in the 
bottom of the main window.



To load a deck, choose “Open” from the File menu.

To save a deck, use “Save” from the File menu. To save a card deck with a different name, choose “Save As.” The 
Card Editor encrypts the card deck as it saves the deck to disk.

To merge card decks together, use the “Append” command under the File menu. Append will take a file on disk 
and add its cards to the card deck in memory, as long as the card deck in memory is the same kind as the card 
deck on disk (if they aren’t the same type, you will receive an error message).

Loading, Saving, and Merging Decks

Getting Statistics for a Deck

The Card Editor provides a way for you to collect information about the makeup of a card deck. To display 
statistics about a deck, choose the “Analyze Deck” command from the Deck menu. The Card Editor will compile a 
list of statistics and then display the results. A sample analysis is shown below:



The first part of the window shows how many cards are in the deck, and how many of them have the “Lose Level” 
box checked. (The more Lose Level cards you have, the faster the players will get undressed.) Generally, you should 
keep the number of “lose level” cards at a quarter of the deck or less. The window then breaks down the number of 
cards at each spice level, and the number of cards which can only be played on men or only be played on women.

The next part of the analysis tells you how many cards can be used at each spice level. When players choose a 
particular spice level, Onyx will play cards at or below that spice level; at Spice Level 3, Onyx will play Level 3, 
Level 2, and Level 1 cards. This part of the analysis also shows you how many cards are available at each dress level. 
If the number of cards available at a certain dress level and spice level is less than 6, it will be displayed in red, 
because that means that in some games there may not be enough cards to go around. (At Spice Level 1, players will 
never reach Dress Level 5, so don’t worry about how many cards are available there.)

For Action decks, you will see information to help you find problems which could prevent the players who are 
using your deck from getting undressed. The statistics window will show you an analysis of how far players can 
undress if they use this deck. For example, let’s suppose that you created a deck which had no “Lose Level” cards 
for Dress Level 4 at Spice Level 2. That would mean that players at Spice Level 2 could never get undressed; there 
aren’t any cards telling them to remove their underwear!

Finally, the statistics window will display a chart showing how many cards are available at each spice level which 
will cause the players to lose a dress level. There should be at least 6 available cards at each dress level and spice 
level; otherwise, players playing at that spice level might not all lose clothing past that dress level.

At the bottom of the window, you will see a list of cards (if there are any) that have problems. For example, let’s 
say that you have made a card that instructs a player to lose clothing, but the card also says it can only be played at 
dress level 5, when the players are already naked. The Card Editor will mark the card as having a problem.

The card deck system as it is currently implemented does have some limitations that you should keep in mind. 
These limitations are:

1. Cards can specify the sex of the target, but not necessarily the sex of the other participants. Don’t make 
assumptions about the sexes of all the players.

2. The Card Editor will allow you to put more than one command to start a timer in a card. You could put a 
command like %m3% in one paragraph (telling Onyx to run a timer for 3 minutes) and %m2% in the second 
paragraph (which will tell Onyx to run a timer for 2 minutes). I have no idea what will happen if you actually do 
this. It will probably cause all sorts of problems. Don’t do it.

Limitations on Cards

Support and Copyright

The Card Editor is copyright 1996-2013 by Franklin Veaux, licensed to Symtoys; all rights reserved.

Visit the Onyx support Web site at
http://www.symtoys.com


